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The Mobius Learning Getting Started guide helps you create classes, find content, and
access data. This guide will give you an overview of the Learning Platform so you can
quickly be up and running in no time.

Adding Courses

The Administrator is responsible for setting up a course and assigning the teacher as an
“Editing Teacher”. This is an easy task as described in the following steps after you have
logged into the LMS:

Locate the Administration “Block” on the “Home” screen, which will be located either in
the right or left navigation panel. These can be on either side of the screen and depends
on what the preferences were when the LMS was setup.

Administration

¥ Front page settings
#" Turn editing on
¥ Edit settings
» Users
T Filters
> Reports

oy Backup

|
=1 Restore

— l\ -
Step #1 - Click Question bank
“Site administration” =@ Site administration
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Step #2 - Click
“Courses”

Administration

* Front page settings

#" Turn editing on

Lo
>
—~

»

0

a7

Edit settings
Users
Filters
Reports
Backup
Restore

» Question bank

+ Site administration

vvvvvvvvvvvvvvaaﬁ

Notifications
Registration

Advanced features
Users

Courses

Grades

Badges

Location
Languages
Plugins

Security
Appearance

Front page

Server

Reports
Development
Assignment upgrade helper
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Step #3 - Click
“Manage courses
and categories”

Administration =

* Front page settings

#" Turn editing on
£¥ Edit settings

b Users

T Filters

F Reports

i Backup

¥1 Restore

» Question bank

+ Site administration

¥ Notifications

L+ Registration

¥ Advanced features
) Users

« Courses

3} Manage courses and categories
4% Add category
L} Restore course
4 Course default settings
¥ Course requests
) Backups

4% Upload courses
Grades

Badges

Location
Languages

Plugins

Security

Appearance

Front page

Server

Reports
Development

v v v v VvV Vv Vv v Vv v wv Ww

Assignment upgrade helper
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Course and category management

Course categories Miscellaneous

Create new category

71 [ Miscellaneous ® Vv e 0w

Sorting

Selected categories - ].

Sort by Category name ascending -

Sort by Course full name ascending >

| sort |
Move selected categories to

- Choose... '-i Move ‘

Viewing: Course categories and courses~

Create new course ~ Sort courses~| Per page: 50 -

Step #4 - Click
“Miscellaneous”
category (or you

can also create a
new category) and
then click on “Create
new course”

Move selected courses to...

" Choose...

'i | Mave ]
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Step #5 is covered in the next several pages of this document. It is taken from the next
screen in the process and there are many options. We will explain each option, which
may or may not apply to your specific needs.

Add a new course

Expand all

General

Course full name * (2

Course short name *

Course category Miscellaneous v
Visible Hide v
Course start date 1 v January v| 2016 v BER

Course ID number

The first thing to do on this page is to click the “Expand all” tabs in the top right hand
corner. This will expand the accordions for this entire page. That is how we will show and
explain all of the options available for this screen.

Enter the course full name

. Enter the course short name: The short name of the course is displayed in the navigation
and is used in the subject line of course email messages.

. Enter the category: This can be in the “Miscellaneous” category or another category you
have created.

. Visible: As you are building a course, it is sometimes a decision to “Hide” the course. To
make it available to students, it will be necessary to unhide the course.

. Course start date: This defines when you want the course to be available to students and
is definable.
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6. Course ID number: The ID number of a course is only used when matching the course
against external systems and is not displayed anywhere on the site. If the course has an
official code name it may be entered, otherwise the field can be left blank.
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* Description

Course summary (7)

Course summary files (7)

+

Bl Files

W
-
&
4
11
1

The course summary is
displayed in the list of
course searches as the
course summary text in
addition to course
names.

Maximum size for new files: Unlimited, maximum attachments: 1

o
o

4

You can drag and drop files h

Course summary files,
such as images, are
displayed in the list of
courses together with the

le%la']mm.a ry'
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Course format

Format Topics Format v
Number of sections 0 v
Hidden sections Hidden sections are shown in collapsed form v
Course layout Show all sections on one page v
Appearance
Force language Do not force Y
News items to show 0
Show gradebook to students Yes ¥
Show activity reports No ¥

Course format:
Format -
The course format determines the layout of the course page.

e Single activity format - For displaying a single activity or resource (such as a
Quiz or SCORM package) on the course page

e Social format - A forum is displayed on the course page

e Topics format - The course page is organized into topic sections

e Weekly format - The course page is organized into weekly sections, with the
first week starting on the course start date

Number of sections -

The numbers of sections are like chapters or some logical breaks in a course.



X
Getting Started

Add a new course

Page | T

Hidden sections -

This setting determines whether hidden sections are displayed to students in

collapsed form (perhaps for a course in weekly format to indicate holidays) or are
completely hidden.

Course layout -

This setting determines whether the whole course is displayed on one page or split
over several pages.

Appearance:

Force language -

This defaults to “Do not force”. There may be times that an instructor may want a

specific language displayed and would want to force to only display a specific
language.

New items to show -

This setting determines how many recent items appear in the latest news block on

the course page. If set to "0 news items" then the latest news block will not be
displayed.

Show gradebook to students -

Many activities in the course allow grades to be set. This setting determines

whether a student can view a list of all their grades for the course via a grades link
in the course administration block.

Show activity reports -

Activity reports are available for each participant that show their activity in the
course. As well as listings of their contributions, such as forum posts or assignment
submissions, these reports also include access logs. This setting determines
whether a student can view their own activity reports via their profile page.
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Files and uploads
Maximum upload size
Completion tracking
Enable completion tracking
Guest access

Allow guest access

Password
Groups
Group mode

Force group mode

Default grouping

Files and uploads:

Files and uploads -

Add a new course

Site upload limit (128 MB) v

Yes v

Yes ¥

Unmask

Yes v
No ¥

Mone ¥
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This setting determines the largest size of file that can be uploaded to the course,

limited by the site-wide setting set by an administrator. Activity modules also
include a maximum upload size setting for further restricting the file size.

Completion tracking:

Completion tracking -

If enabled, activity completion conditions may be set in the activity settings

and/or course completion conditions may be set.
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Guest access:

Allow guest access -

This setting determines whether a user can access the course as a guest, without
being required to enroll.

Password -

A password allows guest access to the course to be restricted to only those who
know the password. Guests will be required to supply the password each time they

access the course.
Groups
Group mode:

This setting has 3 options:

e No groups - There are no sub groups, everyone is part of one big community
e Separate groups - Each group member can only see their own group, others

are invisible
e Visible groups - Each group member works in their own group, but can also

see other groups

The group mode defined at course level is the default mode for all activities within
the course. Each activity that supports groups can also define its own group mode,
though if the group mode is forced at course level, the group mode setting for

each activity is ignored.

Force group mode -

If group mode is forced, then the course group mode is applied to every activity in
the course. Group mode settings in each activity are then ignored.

Default grouping -
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Once some groupings have been created, a default grouping for course activities
and resources may be set.
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Role renaming

Your word for ‘Manager’

Your word for ‘Course Creator’
Your word for ‘Teacher’

Your word for ‘Non-editing teacher’
Your word for ‘Student’

Your word for ‘Guest’

Your word for ‘Authenticated user’

Your word for 'Authenticated user
on front page’

Your word for ‘Parent’

Role renaming

This setting allows the displayed names for roles used in the course to be changed.
Only the displayed name is changed - role permissions are not affected. New role
names will appear on the course participants page and elsewhere within the
course. If the renamed role is one that the administrator has selected as a course
manager role, then the new role name will also appear as part of the course
listings.

After making all of the selections and filling in the course information, save the course.
You have now completed the course setup. The next step is for an Instructor to add
content to the course.
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Assigning an Editing Teacher (Instructor)

To assign an Editing Teacher, the person to be assigned must first be registered as a user
in the LMS. If the person to be assigned has not been registered as a user, the
Administrator must first make that authorization.

If the person being assigned as an Editing Teacher is already registered, the following
method is used.

Administration

* Front page settings
#" Tum editing on
£¥ Edit settings
b Users
T Filters
> Reports
i Backup

|i| Restore

) X ‘
Step #1 - Click Question bank
“Site administration” f========@- site administration
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Step #2 - Click
“Courses”

Administration

* Front page settings

#" Turn editing on

Lo
>
—~

»

0

a7

Edit settings
Users
Filters
Reports
Backup
Restore

» Question bank

+ Site administration

vvvvvvvvvvvvvvaaﬁ

Notifications
Registration

Advanced features
Users

Courses

Grades

Badges

Location
Languages
Plugins

Security
Appearance

Front page

Server

Reports
Development
Assignment upgrade helper
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Course and Category management Viewing: Course categories and courses
Course categories Miscellaneous
Create new category Create new course | Sort courses~| Per page: 50 -
“ [ Miscellaneous ® Vv o3 o + (/) Mathematics - Basic Edition com®mt ¥

Sorting

[ Selected categories = ‘

Step #3 - Choose the
“Category” and
“Course” you want

|. Sort by Category name ascending -

[ Sort by Course full name ascending

- to assign an “Editing
Move selected categories to -
[ Choose... '“ Move] TeaCher

Move selected courses to...

Choose... v] [ Move ‘
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Course and category management Viewing: Course categories and courses~
Course categories Miscellaneous Mathematics - Basic
Edition
Create new category Create new course | Sort courses~| Per page: 50 ~
View | Edit | Enrolled users  Delete| Hide | Backup
v) [l Miscellaneous ® Vv o 18 + (/) Mathematics - Basic Editon @& o ® 4 ¥
Sorting

—— | Step #4 - Choose to “View”
S— - the course as indicated.

Sort by Course full name ascending -J
Sort

Move selected categories to

: Choose... '| Move J

Move selected courses to...

_ Choose... v| | Move
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Administration o

¥ Course administration
#" Tumn editing on
£¥ Edit settings

Step #5 - Choose £¥ Course completion
“Users”. Notice that =@ ) Users
although the block Y Filters

is titled } Reports

“Administration”,
this is the course
“Administration”.

Administration =

¥ Course administration
#" Turn editing on
£¥ Edit settings

Step #6 - Choose £¥ Course completion
“Enrollment ) v Users

methods” 2. Enrolled Users
) Enroliment methods

) Groups
) Permissions
L. Other users
T Filters
F Reports




X
Getting Started Guide

Administrators Guide - Add/Edit a Teacher

Mathematics - Basic Edition

Enrollment Methods

Step #7 - Choose the e hos thoon B

icon circled in yellow ® | e sreiner B O
Guest access o®

(Enrou userS) :&Hsnrullnwm{swdsnt] :* [ R ¥

Add method | Choose... -

Mathematics - Basic Edition

Manual enrollments

Enrolled users #3 Not enrolled users.

« Add Not o= i users (1)
Your Editing Teacher (teacher@yourinstition

< #2

Enrolled users (0)

Assign rofe
Student v

s #1

Manager
Teacher
Nen-editing teacher

Step #8 - Choose the drop
= down menu under “Assign

role” and select “Teacher”.
Select the teacher in the
right box you want to

Search | Remaove »

Search options >

assign to the course. Then
click the “Add” button.
Verify the assignment in
the left box.
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Mathematics - Basic Edition

Manual enrollments

Enrolled users Not enrolled users

Enrol'= 2 usurs (1) « Add Mot enrolled users (0)
Your Editing Teacher (teacher@yourinstition
.com)
Assign role

Student v

Enroliment duration

Unlimited ¥

Notice that you have assigned I
an Editing Teacher for the =T
Mathematics - Basic Edition

course in the “Enrolled users”

Remove »

in the left box. You have now -
completed the assignment of

an “Editing Teacher” for a

course.
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The Mobius Learning Getting Started guide helps you create classes, find content, and
access data. This guide will give you an overview of the Learning Platform so you can
quickly be up and running in no time.

Duplicating Courses

The Administrator is responsible for replicating/duplicating a course and assigning the
teacher as an “Editing Teacher”. This is an easy task as described in the following steps
after you have logged into the LMS:

Locate the Administration “Block” on the “Home” screen, which will be located either in
the right or left navigation panel. These can be on either side of the screen and depends
on what the preferences were when the LMS was setup.

Administration

¥ Front page settings
#" Turn editing on
¥ Edit settings
» Users
T Filters
> Reports
oy Backup

|
=1 Restore

: l\ .
Step #1 - Click Question bank
“Site administration” =@ Site administration
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Step #2 - Click
“Courses”

Administration

* Front page settings

#" Turn editing on

Lo
>
—~

»

0

a7

Edit settings
Users
Filters
Reports
Backup
Restore

» Question bank

+ Site administration

vvvvvvvvvvvvvvaaﬁ

Notifications
Registration

Advanced features
Users

Courses

Grades

Badges

Location
Languages
Plugins

Security
Appearance

Front page

Server

Reports
Development
Assignment upgrade helper
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Step #3 - Click
“Manage courses
and categories”

Administration =

* Front page settings

#" Turn editing on
£¥ Edit settings

b Users

T Filters

F Reports

i Backup

¥1 Restore

» Question bank

+ Site administration

¥ Notifications

L+ Registration

¥ Advanced features
) Users

« Courses

3} Manage courses and categories
4% Add category
L} Restore course
4 Course default settings
¥ Course requests
) Backups

4% Upload courses
Grades

Badges

Location
Languages

Plugins

Security
Appearance

Front page

Server

Reports
Development

v v v v VvV Vv Vv v Vv v wv Ww

Assignment upgrade helper

Page | 4



(X
Getting Started Guide

Administrators Guide - Duplicating a Course

Page | 5
Course Category management Viewing: Course categories and courses -
Course categories Masters
Create new category Create new course | Sort courses ~ | Per page: 20~
B Masters S o 4 W Anatomy Physiology 1 aXe
* Masters CATEGORY 1 @ 4y o 3Q < [0 Anatomy Physiology 2 o X
= Masters CATEGORY 2 @ 4§ o 60 < W Chemistry o X

Move selected course to...

Choose... m

Sorting

_ Selected categories  ”

Sort by Category name ascending

Step #4 - Click the
category where the
course you want to
duplicate is located.
In this example we
will use the “Masters
CATEGORY 17.

Sort by Course full name ascending

| Sot |
Choose... N m
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Course category management

Course categories Masters

Create new category

Move selected course to...

o Anatomy Physiclogy 1
ofe Anatomy Physiology 2

Create new course | Sort courses - | Per page: 20~

Page | 6

Viewing: Course categories and courses -

o X
O X=
O X =

Bl Masters = | G- 0o
* Masters CATEGORY 1 @ h b O- 14
* Masters CATEGORY 2 @ O (] 3 Chemistry
Choose...
Sorting

Selected categories  *

Sort by Category name ascending

Sort by Course full name ascending

Step #5 - Click the
course you want to
duplicate/copy.

Choose...

Step #5 is covered in the next several pages of this document. It is taken from the next

screen in the process and there are many options. We will explain each option, which

may or may not apply to your specific needs.

Add a new course

” General

Course full name  * (2

Course short name * ()

Course category (7) Miscellaneous v
Visible () Hide v
Course start date (7) 1 ¥ January ¥ | 2016

Course ID number (7)

b Expand all



X
Getting Started Guide

Duplicating a Course Page | 7
The first thing to do on this page is to click the “Expand all” tabs in the top right hand

corner. This will expand the accordions for this entire page. That is how we will show and
explain all of the options available for this screen.

Enter the course full name

. Enter the course short name: The short name of the course is displayed in the navigation
and is used in the subject line of course email messages.

. Enter the category: This can be in the “Miscellaneous” category or another category you
have created.

. Visible: As you are building a course, it is sometimes a decision to “Hide” the course. To
make it available to students, it will be necessary to unhide the course.

. Course start date: This defines when you want the course to be available to students and
is definable.

. Course ID number: The ID number of a course is only used when matching the course
against external systems and is not displayed anywhere on the site. If the course has an
official code name it may be entered, otherwise the field can be left blank.
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* Description

Course summary (7)

Course summary files (7)

+

Bl Files

The course summary is
displayed in the list of
course searches as the
course summary text in
addition to course
names.

Maximum size for new files: Unlimited, maximum attachments: 1

4

You can drag and drop files h

o
o

Course summary files,
such as images, are
displayed in the list of
courses together with the

le%la']mm.a ry'
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Course format

Format Topics Format v
Number of sections 0 v
Hidden sections Hidden sections are shown in collapsed form v
Course layout Show all sections on one page v
Appearance
Force language Do not force Y
News items to show 0
Show gradebook to students Yes ¥
Show activity reports No ¥

Course format:
Format -
The course format determines the layout of the course page.

e Single activity format - For displaying a single activity or resource (such as a
Quiz or SCORM package) on the course page

e Social format - A forum is displayed on the course page

e Topics format - The course page is organized into topic sections

e Weekly format - The course page is organized into weekly sections, with the
first week starting on the course start date

Number of sections -

The numbers of sections are like chapters or some logical breaks in a course.
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Hidden sections -

This setting determines whether hidden sections are displayed to students in

collapsed form (perhaps for a course in weekly format to indicate holidays) or are
completely hidden.

Course layout -

This setting determines whether the whole course is displayed on one page or split
over several pages.

Appearance:

Force language -

This defaults to “Do not force”. There may be times that an instructor may want a

specific language displayed and would want to force to only display a specific
language.

New items to show -

This setting determines how many recent items appear in the latest news block on

the course page. If set to "0 news items" then the latest news block will not be
displayed.

Show gradebook to students -

Many activities in the course allow grades to be set. This setting determines

whether a student can view a list of all their grades for the course via a grades link
in the course administration block.

Show activity reports -

Activity reports are available for each participant that show their activity in the
course. As well as listings of their contributions, such as forum posts or assignment
submissions, these reports also include access logs. This setting determines
whether a student can view their own activity reports via their profile page.
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Files and uploads
Maximum upload size
Completion tracking
Enable completion tracking
Guest access

Allow guest access

Password
Groups
Group mode

Force group mode

Default grouping

Files and uploads:

Files and uploads -

Duplicating a Course

Site upload limit (128 MB) v

Yes v

Yes ¥

Unmask

Yes hd
No ¥

Mone ¥
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This setting determines the largest size of file that can be uploaded to the course,

limited by the site-wide setting set by an administrator. Activity modules also
include a maximum upload size setting for further restricting the file size.

Completion tracking:

Completion tracking -

If enabled, activity completion conditions may be set in the activity settings

and/or course completion conditions may be set.
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Guest access:

Allow guest access -

This setting determines whether a user can access the course as a guest, without
being required to enroll.

Password -

A password allows guest access to the course to be restricted to only those who
know the password. Guests will be required to supply the password each time they

access the course.
Groups
Group mode:
This setting has 3 options:

e No groups - There are no sub groups, everyone is part of one big community
e Separate groups - Each group member can only see their own group, others

are invisible
e Visible groups - Each group member works in their own group, but can also

see other groups

The group mode defined at course level is the default mode for all activities within
the course. Each activity that supports groups can also define its own group mode,
though if the group mode is forced at course level, the group mode setting for

each activity is ignored.

Force group mode -

If group mode is forced, then the course group mode is applied to every activity in
the course. Group mode settings in each activity are then ignored.

Default grouping -

Once some groupings have been created, a default grouping for course activities
and resources may be set.
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Role renaming

Your word for ‘Manager’'

Your word for ‘Course Creator’
Your word for ‘Teacher’

Your word for ‘Non-editing teacher’
Your word for ‘Student’

Your word for ‘Guest’

Your word for ‘Authenticated user’

Your word for 'Authenticated user
on front page’

Your word for ‘Parent’

Role renaming

This setting allows the displayed names for roles used in the course to be changed.
Only the displayed name is changed - role permissions are not affected. New role
names will appear on the course participants page and elsewhere within the
course. If the renamed role is one that the administrator has selected as a course
manager role, then the new role name will also appear as part of the course
listings.

After making all of the selections and filling in the course information, save the course.
You have now completed the course setup. The next step is for an Instructor to add
content to the course.
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The Mobius Learning Getting Started guide helps you enroll users in the LMS. This guide
will give you an overview of the Learning Platform so you can quickly be up and running
in no time.

Enrolling Users in the LMS

The Administrator, in most cases, is responsible for the enroliment of users in the LMS.
That includes Managers, Teachers, and Students. In this guide, we will describe a couple
of popular methods, but be aware that there are several methods that will work.

Manual Method to Enroll Users in the LMS

Locate the Administration “Block” on the “Home” screen, which will be located either in
the right or left navigation panel. These can be on either side of the screen and depends
on what the preferences were when the LMS was setup.

Administration =

¥ Front page settings
#" Tumn editing on
¥ Edit settings
» Users
T Filters
> Reports
L1 Backup
1 Restore

Step #1 - Click » Question bank
“Site administration” f=======@- site administration
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Administration

* Front page settings
#" Turn editing on
£¥ Edit settings
b Users
T Filters
F Reports
i Backup
¥1 Restore
» Question bank

+ Site administration
Notifications
Registration

Advanced features
Users
Courses

Step #2 - Click
‘Users”

Grades
Badges
Location
Languages
Plugins
Security
Appearance
Front page

vvvvvvvvvvﬁﬁﬁ
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Administration =

* Front page settings
#" Turn editing on
£F Edit settings
b Users
T Filters
F Reports
) Backup
*1 Restore
b Question bank

v Site administration
#F Notifications
L} Registration
£+ Advanced features
) Users

. * Accounts
Step #3 - Click ,
“ACCOU nts!! and ﬁ Browse list of users

7 o £+ Bulk user actions
Add a new user £ Add a new user

£+ User default preferences
£+ User profile fields

¥ Cohorts

¥ Upload users

¥ Upload user pictures
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Step #4 is covered in the next several pages of this guide. It describes the information
you will enter when manually setting us a new user in the LMS.

Expand all

General

Username*

Choose an authentication method (2
Y Y i
| ] Manual accounts
;23 anua

*/3\' Suspended account (2)
)

Generate password and notify user

New password (7

Force password change

;"7;\ First name*
)

7o Last name*
A 8;

1) First enter a user name. A typical practice is to use the first initial and full last
name. Note that this must be all lower case letters.

2) If you have no additional authentication methods for your LMS (i.e. Single-Sign-
On), this should be left as “Manual accounts”, which is the default.

3) Youdon't need to do anything here, but you should note that latter if you want to
suspend a user, you can come back to this page and click the “Suspend account”.
This will stop the user from accessing the LMS, but will keep their user
information including grades.

4) “Generate password and notify user” is the preferred method of providing a new
user with information regarding their access to the LMS. This will also eliminate
the Administrator for sending them an email, because the system sends one
automatically if this box is checked.

5) If you do not check the previous box, you can manually set a password for a user.
In creating a new user, you would then need to send the user their login
information (URL, User Name, and Password).
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6) “Force password change” is a good box to check. This requires the new user to
enter a new password when they log in to the LMS the next time they login to
the LMS.

7) “First name” is simply the first name of the new user. The system uses this in
multiple places, so this is important information.

8) “Last name” is simply the last name of the new user. The system uses this in
multiple places, so this is important information.

9 mall address*

Email display

City/town

)
@)
Select a country
2

Timezone

Description

9) “Email address” is the users email address and is very important for the system.
All communication from the LMS is via. Email, so this information is used from
everything from password resets, to a teacher communicating with a user.

10) “Email display” has a default to “Allow only other course members to see my
email address”. This can be set to “Hide my email address from everyone” or
“Allow everyone to see my email address”.

1) “City/Town” is information that is optional.

12) “Select a country” is information that is optional.

13) “Timezone” can be set for a user and is optional.

14) “Description” is information about the user and will be displayed on their profile
page. This is optional.
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16)
17)

18)
19)

20)
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- User picture

Current picture

. Delete
@®
New picture (7

> (Gl Files

Picture description

a8
» Additional names
A9 » Interests

» Optional

This indicates if the user has a “Current picture”. For a new user there will be no
picture indicated.

“Delete” is used here to only delete the users picture.

“New picture” is where you can drag and drop a new users picture and is
optional.

“Picture description” can be any name you assign to the picture and is optional.
“Additional names”, “Interests”, and “Optional” is all information that can be
included for a user description and is all optional.

“Create user” is the last step in manually creating a user. When you click this
button and have completed all of the required items as indicated by the “*”
(asterisk) beside the description of each item, the user will be created in the LMS
and they will have access based on the information entered.
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Upload Users

If you have multiple users to upload at one time, this method is useful. You will want to
pay close attention to the instructions, because if done incorrectly will result in users not
being loaded in the LMS.

Locate the Administration “Block” on the “Home” screen, which will be located either in
the right or left navigation panel. These can be on either side of the screen and depends
on what the preferences were when the LMS was setup.

Administration

* Front page settings
#" Tum editing on
£¥ Edit settings
b Users
T Filters
> Reports
i Backup
*1 Restore

) N i
Step #1 - Click Question bank
“Site administration” =@ site administration




Getting Started Guide

Administrators Guide - Upload Users into Moodle

Administration

* Front page settings
#" Turn editing on
£¥ Edit settings
b Users
T Filters
F Reports
i Backup
¥1 Restore
» Question bank

+ Site administration
Notifications
Registration

Step #2 - Click

“Users”

Advanced features
Users
Courses

Grades
Badges
Location
Languages
Plugins
Security
Appearance
Front page

vvvvvvvvvvﬁﬁﬁ

Page |10
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Administration =

* Front page settings
#" Turn editing on
£F Edit settings
b Users
T Filters
b Reports
) Backup
*1 Restore
b Question bank

v Site administration
#F Notifications
¥ Registration
£+ Advanced features
) Users

. * Accounts
Step #3 - Click ,
“ACCOU nts!! and ﬁ Browse list of users

7 : £+ Bulk user actions
Upload users £+ Add a new user

£+ User default preferences
£+ User profile fields

¥ Cohorts

¥ Upload users

1} Upload user pictures

Page | T
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Upload users

~ Upload

File*

ST LR [ 1aximum size for new files: 225MB
@ v

You can drag and drop files here to add them

CSV delimiter

Encoding
'__:_3: ITE-8

Preview rows
<

There are required fields in this form marked *

1) After you have setup your .csv file, drag the file to this upload area. You must make
sure the .csv file is formatted correctly or the users will not be uploaded. We wiill
explain that process latter in this guide.

2) You can define what type of .csv file you are uploading. The default is “comma”
delimitated, which is a typical file type. If you are using Excel to develop the file,
make sure to save it as a “comma” delimitated file type.

3) The typical encoding is UTF-8, but you can change the encoding to the file type
you are using.

4) “Preview rows” allows you to see how the .csv file is interpreted by the LMS. It is
always a good idea to take a careful look at this preview before proceeding. This
setting defines the number of rows that will be viewable.

5) “Upload Users” button is the final step in preparing the file for upload.
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This step in uploading users is the most important to prepare the .csv file correctly. In
this step, we are describing the use of Microsoft Excel to develop the file and then we

will save it as a comma delimited .csv file.

You will need at a minimum the following information about each user must be upload:

Username

User First Name
User Last Name
User Email Address

File formats for upload users file

The upload users file has fields separated by a comma (or other delimiter) ONLY - no
space. The first line contains the valid field names. The rest of the lines (records) contain

information about each user.

Tip: Avoid special characters in field information like quotes or other commas. Test
a file with only one record before a large upload.

Tip: You can use a spread sheet program to create the file with the required
columns and fields. Then save the file as "CSV (comma delimited)". These files can

be opened with simple text editors for verification.

Valid upload file for testing

Here is an example of a simple valid upload file: (Column headers on the first line of the
file are only highlighted in bold in this example to distinguish it from the rest of the of

the data/user details)
username,password,firstname,lasthame,email,coursel,groupl,cohortl
jonest,verysecret,Tom,Jones,jonest@someplace.edu,math102,Section 1,year

3
reznort,somesecret,Trent,Reznor,reznort@someplace.edu,math102,Section

3,year 4
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Fields that can be included

Tip: We strongly recommend that you test a file that contains fields you proposed to use
with one user before attempting a file upload for the first time.

e Required fields:
username,firstname,lastname,e
mail
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Validity checks are performed for:

1. username can only contain alphabetical lowercase letters , numbers, hypen
'-', underscore '_', period '.', or at-sign '@’

2. email is in the form: name@example.com .

o Password field: "password" field is optional if "Create password if needed" setting
is chosen (default).

o Ifincluded, values should meet the requirements for the site's Password
policy. To force password change for a particular user, set the password field
to changeme.

o If omitted, a password will be generated for each user (during the next Cron
job) and welcome e-mails sent out.

e Optional fields: To provide values other than the default include one or more of
these
institution,department,city,country,lang,auth,timezone,idnumber,icq,phonel,
phone2,address,url,description,mailformat,maildisplay,htmleditor,autosubscri
be

e Additional name fields

e Country- use a country TWO LETTER CODE

e The auth field must be used if the site uses an alternative authentication method,
such as LDAP, as otherwise the authentication method will default to manual and
users using a different auth method won't be able to log in.

e Some fields have a maximum number of characters that are allowed (notably
institution should be at most 40 characters long). See hints below.

e Maildisplay, htmleditor and autosubscribe can be set from an import screen.

e Custom profile field names: (Optional). xxxxx is the real custom user profile field
name (i.e. the unique shortname)
profile_field _xxx
XX

Create the custom fields BEFORE importing. Use the standard header. The
"shortname" for your custom field is xxxxx (NB the shortname must be all
lowercase, otherwise won't be recognized). The first record must include
"profile_field _xxxxx".

Example: To create a custom field "genre", you must write a shorthame "genre" in
the new field, and write "profile_field_genre" in the header of the .csv file.
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For custom profile fields that are a menu, use the corresponding value.

For custom profile fields that are dates, use the ISO standard format YYYY-MM-DD,
eg. 2014-06-19 which will then be properly localized in the interfaced.

Example: A custom field 'Department' with one of three values 'HR', 'Marketing' or
‘Training'. Just insert one of those three words (e.g. 'Training') as the value for that
field.

e Special fields: Used for changing of usernames or deleting of users
oldusername, deleted, suspended

e Enrolment fields: (Optional):

coursel,typel,rolel,groupl,enrolperiodl,enrolstatusl,course2,type2,role2,
group2,enrolperiod2,enrolstatus2 etc.

0 Header fields must have a numeric suffix such that typel, rolel, group],
enrolperiodl and enrolstatus1 all apply to coursel for coursel to course n.

0 course is the "shortname" of the course, if present the user will be enrolled in
that course.

o0 type sets the role to be used for the enrolment. A value of 1is default course
role, 2 is legacy Teacher role and 3 is legacy Non-editing Teacher.

o0 role may be used to specify roles directly, using either role short name or id
(numeric names of roles are not supported).

0 group may be used to assign users to groups in course, using name or id
(numeric group names are not supported)

o0 enrolperiod may be used to set the enrolment duration, in days, for each
course.

o enrolstatus can suspend users from a course when set to 1 or left blank for
enrolled.

e Cohort field: (Optional):
cohortl

Internal cohort id numbers or non-numeric Cohort IDs of existing cohorts must be
used; names are not allowed.

e mnethostid (Optional)

Existing MNetusers can be added to courses, groups or cohorts as below:
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1. enrolling to courses: username+mnethostid+course required

2. adding to group: username+mnethostid+course+group required

3. adding to cohort: username+mnethostid+cohort required

4, suspending/reviving accounts: username+mnethostid+suspended required

All other operations are ignored. You can not add users, delete them or update them
(such as change names or email, profile fields, etc.)
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System role (Optional)

sysrolel,sysrole2,sysrole3
etc

Users may be uploaded to a system role (usually Manager or Course creator) by
entering the shortname of that role. Other roles can only be uploaded if they have
already been assigned in the 'system' context. See Creating custom roles. Multiple
roles can be assigned using sysrole2, sysrole3, etc. fields. Note that the number
suffix in no way relates to the number suffixes on the enrolment fields. The
numbers must go up in sequence starting at 1.

Unassigning roles

Users can also be removed from a given system role by entering the shortname of
that role prefixed with a minus symbol: '-'. If the user is currently assigned to that
role, they are removed from it. If the user is not currently assigned to that system
role, the field value is ignored. However, the field value must refer to a system role
that does exist on the system, otherwise an error will occur.

F13 - y o
A B 0 (] E
1 username password firstname lastname email sysrolel
2 jdep 1234 lohnny  Depp depp@Eexample.com manager
% bbardot 1234 Brigitte  Bardot bbardot@example.com Coursecreator

Example of a file for uploading users with global/system roles e

Commas within a field must be encoded as &#44 - the script will decode these
back to commas.

For Boolean fields, use @ for false and 1 for true.

To prevent users from receiving a large number of emails from courses or forced
subscription forums use the maildigest. The options for this field are O = No digest,
1= Complete digest and 2 = Digest with just subjects.
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Upload user process

1. Create file for uploading

2. Go to Site administration > Users > Accounts > Upload users

3. Add file to upload

4. Upload users preview - check settings and default user profile settings

5. Upload users preview - click "Upload users"

6. Upload users results - shows list of users, exceptions made in upload and

summary of number of users
Upload users results - click "Continue"
8. Returns to Upload users screen

N

Updating users preview

There are various settings to better control the desired upload behaviour. These settings
are found on the "Upload users preview" page.

Warning: errors updating existing accounts can affect your users badly. Be careful when
using the options to update.

Upload type
The Upload type specifies how to handle existing accounts.
Add new only, skip existing users

is the default Moodle upload type. It creates a new user account for each new
record in the uploaded file. If an existing username is found (i.e., the username in
the uploaded file matches an existing username, that record is skipped. By
skipping the existing user account, the data in the existing record is not touched
(in contrast to the "Add new and update existing users" option) and a second new
user account is not created (in contrast to the "Add all, append number to
usernames if needed" option).

Add all, append number to usernames if needed

creates a new user account for each record in the uploaded file. If an existing user
account is found, a new account will be created with a number appended to the
username. For example, if a user account for username 'jsmith' already exists and a new
record in the uploaded file contains a record for username 'jsmith' an additional user
account is created with a1 appended to the username to produce user 'jsmithl'.

Add new and update existing users
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creates a new user account for each new user in the upload file. If an existing user
account with the same username is found, the account information is updated by the
data in the uploaded file.

Update existing users only

ignores any new users found in the upload file and updates the user account if a
matching username record is found in the uploaded file.

New user password

When creating a new user account Moodle can create a new password (if one is not
provided) or require a password in the uploaded file.

Create password if needed

creates a default password for the new user account if one is not provided in the
uploaded file.

Field required in file

requires that a password be provided in the uploaded file in order. If a password is
not provided, an error is generated and the user account is not created.

Existing user details

The Existing user details options are only available when the Upload type allows existing
user accounts to be updated. It specifies how Moodle should process user detail
information for existing users.

No changes

ignores user detail data in the uploaded and leaves the existing user account data
unchanged.

Override with file

overwrites data in the existing user account with the data provided in the
uploaded file.

Override with file and defaults

overwrites data in the existing user account with data provided in the uploaded file
and fills in the default values for existing user details when no data is provided in
the uploaded file.
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Fill in missing from file and defaults

adds data in the existing user account with data provided in the uploaded file if the
field is empty (does not already contain data) and fills in the default values for
existing user details when no data is provided in the uploaded file.
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Existing user password

The Existing user password option specifies how to handle password data for existing
user accounts when Existing user details is set to overwrite data.

No changes

ignores password field in the uploaded user file and leaves the existing user
account password untouched

Update

overwrites the existing user account password with the password provided in the
uploaded file

Force password change

The Force password change option specifies when to tag a user account so that the next
login attempt will require the user to change the user's password.

Users having a weak password

If the user account has a weak password as defined by the stie's Password policy
then the user will be forced to change the password during the next login attempt.
This option is not shown if there the site does not have a Password policy, in other
words $CFG->passwordpolicy must be set to see this option.

None

None of the users in the uploaded file will be forced to change the password
during the user's next login attempt.

All
All of the users in the uploaded file will be forced to change the password during
the user's next login attempt.

Allow renames

If the uploaded flie contains the special oldusername field, it is possible to rename a user
from the oldusername to a new username. The default setting is to not allow renames.
Keep in mind that renaming a user will require the user to use the new username when

logging in.
No
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ignores the oldusername field and leaves the existing user account's username
field unchanged.

Yes
allows the existing user account's username to be changed by the data provided in
the uploaded file's username field. The oldusername will be searched for and then
updated with the data provided in the username column.

Allow deletes

If the uploaded file contains the deleted special field, it is possible to use the upload file
to delete existing user accounts. The default setting is to not allow deletes. Keep in mind
that deleting a user account will prevent that user from logging in. As a protection, site
administrator user accounts cannot be deleted with this method.

No

ignores the deleted special field in the uploaded file and leaves the existing user
account unchanged

Yes

allows the existing user account to be deleted when the value of the of the deleted
field is 1.

Allow suspending and activating of accounts

If the uploaded file contains the suspended special field, it is possible to use the upload
file to either suspend or make active (unsuspend) existing user accounts. The default
setting is to allow suspending/activating of existing user accounts. Keep in mind that
suspending an existing user account will prevent that user from logging in.

Yes

allows the existing user account to be suspended when the value of the of the
suspended field is 1.

No

ignores the suspended special field in the uploaded file and leaves the existing
user account status unchanged.
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Prevent email address duplicates

It is possible, but not recommended to upload users with duplicate email addresses. By
default, uploading users with duplicate email addresses is prevented.

To allow duplicate email addresses, go to Site administration » Plugins »
Authentication » Manage authentication. You can tick "Allow accounts with same
email". Then on the upload users screen you will be allowed to change the "Prevent
email address duplicates" setting. However, doing this is not recommended. For more
info, see the Managing authentication docs page

Yes
prevents user accounts from being created from the uploaded if an existing user
account already has the same email address as found in the uploaded file's email
column.

No

allows user accounts to be created if an existing user account already has the
same email address found in the uploaded file's email column.

Standardize usernames

Standardize usernames is used by default to convert the username to all lower case and
to strip out illegal characters. It is possible to not standardize the usernames; however,
doing so is not recommended.

Yes
standardizes usernames found in the uploaded file before updating existing or
creating new user accounts so that the username contains only lowercase letters
and numbers.

No

skips standardizing usernames found in the uploaded file so that the newly
created or updated usernames will be exactly as they are in the uploaded file (hot
recommended).

For those seeking a more technical explanation, the process for standardizing the
usernames consists of ensuring the characters are all UTF-8 (fix_utf8) encoded,
converting the username to lower case, and then stripping out non-letters/non-number
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characters (unless $CFG->extendedusernamechars is set to true) with something similar
to:

$username = preg_replace('/[ -\.@_a-z0-9]/", ",

$username);

Select for bulk user actions

After the uploaded file has finished being processed (all new accounts have been
created and existing accounts updated as specified by the previous settings), there is an
option to select some of those user accounts to perform additional bulk user actions
such as

e Confirm user accounts created through Email-based self-registration which are
not yet confirmed by the user

e Send a message (requires Messaging to be enabled)

e Delete user accounts

e Display a list of users on a page

e Download user data in text, ODS or Excel file format

e Force users to change their passwords

e Add users to a cohort

By default, no users are selected for bulk user actions.
No

No users are selected for bulk user actions
New users

Only newly created users are selected for bulk user actions
Updated users

Only updated user accounts are selected for bulk user actions
All users

All users found (existing updated users and newly created user accounts) in the
uploaded file are selected for bulk user actions

Default values

You can provide default user values for some fields not included in the uploaded file.
Some fields include:
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e Email display

e Forum auto-subscribe
e City/town

e ID number

e Institution

e Department

Upload user results

After accepting the preview settings by clicking on "Upload users", you should see the
the Upload users results screen.

Uplcad usi s runalls

FERE CIVE D UBHTENE IIMESE DETHE PO RaeEL FHISNT SOWOLCIEYT EWOIRETH  DHHE

Py s M, shdleis WL o g v T £
The results screen; everything wentwelll =

This screen will show you any exceptions or changes that were made to each user in the
upload process. For example if you were updating user information, the updated
information will be shown. Or if a user was not added that record will be highlighted.

The screen will summarize how many users were uploaded or updated, indicate the
number of weak passwords and the number of errors.

Templates

Note: This section needs checking and updating if necessary for Moodl/e 2.0. Please do
so and remove this note when finished.

The default values are processed as templates in which the following codes are allowed:

e %l - will be replaced by the lasthame
e %f - will be replaced by the firsthame
e %u - will be replaced by the username
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%% - wWill be replaced by the %

Between the percent sign (%) and any code letter (I, f or u) the following modifiers are
allowed:

(-) minus sign - the information specified by the code letter will be converted to
lowercase

(+) plus sign - the information specified by the code letter will be converted to
UPPERCASE

(~) tilde sign - the information specified by the code letter will be converted to
Title Case

a decimal number - the information specified by the code letter will be truncated
to that many characters
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For example, if the firsthame is John and the lasthame is Doe, the following values will
be obtained with the specified templates:

e %I%f = Doelohn

e %l%1f = Doel

e %-1%+f = doeJOHN

e %-f_%-1=john_doe

e http://www.example.com/~%u/ results in http://www.example.com/~jdoe/ (if
the username is jdoe or %-1f%-I)

Template processing is done only on default values, and not on the values retrieved from
the CSV file.

In order to create correct Moodle usernames, the username is always converted to
lowercase. Moreover, if the "Allow extended characters in usernames" option in the Site
policies page is off, characters different to letters, digits, dash (-) and dot (.) are removed.
For example if the firstname is John Jr. and the lastname is Doe, the username %-f_ %-I
will produce john jr._doe when Allow extended characters in usernames is on, and
johnjr.doe when off.

When the "New username duplicate handling" setting is set to Append counter, an auto-
increment counter will be append to duplicate usernames produced by the template.
For example, if the CSV file contains the users named John Doe, Jane Doe and Jenny
Doe without explicit usernames, the default username is %-1f%-1 and New username
duplicate handling is set to Append counter, then the usernames produced will be jdoe,
jdoe2 and jdoe3.

If the deleted field is present, users with value 1 for it will be deleted. In this case, all the
fields may be omitted, except for username. After uploading the file, be sure to change
the "Upload type" to "Update existing users only" and the "Allow deletes" option to "Yes".

Tip: A similar field is available for suspended. This enables a user account to be
temporarily disabled rather than completely removed.

Deleting and uploading accounts could be done with a single CSV file. For example, the
following file will add the user Tom Jones and delete the user reznort:

username,firstname,lastname,dele
ted
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reznort,,,1
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On the initial Upload user screen, you may select the file encoding format from a puli
down list. These include UTF-8 (the default), ASCII, ISO-8859-1to ISO-8859-11 or any one
of over 36 formats.

Hints
Spreadsheet

If you use a spreadsheet program such as Excel to create your .csv file, check the
resulting output in a text editor before you upload it. It is possible to get trailing commas
on each line from an empty field if you have added and deleted columns of information
prior to saving the final file. Also check the character encoding. A csv file is a simple text
file (ASCIl or Unicode) that can be used to upload user accounts.

Excel translates passwords that begin with - (minus) or + (plus) as zero. Even when
saving as .csv and saying "Yes" to "Keep this format, and leave out any incompatible
features." Check for this before uploading, as a zero halts the upload process.

If you use a formula in Excel to create fields (for example, the concatenate function to
create a user name), then remember to copy the cells with the formula and use special
paste with values checked to make them into an acceptable data for a csv file.

The upload will also fail if you have trailing spaces at the end of your data fields. Often,
this can not be removed with a simple Find " " and Replace with "". If information has
been copied from web sources than it is possible to include non-breaking spaces which
will prevent your upload from being completed correctly. To find these invisible spaces,
use the Find and Replace function in Excel. In the find field, hold alt and type 0160. Leave
the replace field blank.

Country

The country should be written as a two letter code, in capitals. For example, use BE for
Belgium or NL for the Netherlands. Using "be" or "nl" or "USA" as a country code will
result in a database error.

Tip: If you are having trouble working out the two-letter code for a country, you
can consult the list of country names and code elements available on the ISO
Website. A common error is to use UK for United Kingdom; it should be GB.

Field size limits
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Some fields have maximum character lengths. Typically the file will import to the
preview list screen but not finish the process. Turn on debug to see the fields that are
too long. Common fields to cause problems are "Institution" which is limited to 40
characters, and "City", also limited (20 characters). The error will be "User not added -
error".

Time zones
The entry is case sensitive so Europe/London will work but europe/london will not.
All fields listed here

All the fields that are valid are listed below, except for any custom fields you may have
created.

firstname, lastname, username, email, city, country, lang, timezone, mailformat,
maildisplay, maildigest, htmleditor, ajax, autosubscribe ,institution, department,
idnumber, skype , msn, aim, yahoo, icq, phonel, phone2, address, url, description,
descriptionformat, password, auth, oldusername, deleted, suspended, coursel, course2,
course3, course4

Enroll users to Cohorts (system groups)

You can enroll users to any Cohort (system level group) by using only the "username" and
the "Cohort ID". Here is a sample CSV file:

username,cohortl
teacherl,system-
teachers
teacher2,system-
teachers
teacher3,system-
teachers

Make sure you set "Upload type" to "Update existing users only" (So you are not asked to
add firsthname, lastname and email fields too)
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